Chapter 1

Graphics 1

Introduction

Successful teachers plan for the use of visual support. Visuals are an effective way of supporting the lesson content. Visuals may be either projected (onto a screen or monitor) or non-projected (handouts, black/white boards, flipcharts…). Most visuals contain graphics which are valuable to both projected and non-projected visuals because they, like colour, focus attention on what is important. They can be used to clarify understanding, capture interest and add humour.

To be effective the number of graphics should be limited. Their impact may decrease and can even serve as a red herring if used frequently.

Graphics is a Language

No matter what language you speak, graphics is one language you can always use to communicate. It’s a language we all speak and understand.

Different graphics appear under and in different forms: photographs and slides, magazines and newspapers, brochures and leaflets. At this point in time we will be dealing with computer graphics.

Computer Graphics

"is concerned with all aspects of producing pictures or images using a computer" (Angel 1989)

"is a set of tools to create and interact with pictures." (Hill 1990)

Basically in this section we will be dealing with producing pictures –

1. To use in :
   - handouts
   - charts
   - presentations
   - web pages
   - newsletters
2. Created:

- through a scanner
- through a digital camera
- from clipart galleries (commercially available CD’s, internet, MS Office)
- by freehand drawing

3. By using:

- a paint program (MS Paint)
- drawing tools in (MS Publisher, MS Word, PowerPoint)

There are a couple of basics things to consider when discussing computer graphics. First of all, there are two basic types of computer graphics. The two types are vector graphics and raster graphics (bitmap).

Vector graphics - are comprised of a series of mathematically defined objects.

Raster graphics (bitmap) - on the other hand are comprised of individual picture elements (called pixels).

What do these definitions mean? Well there are a number of ways that vector and raster graphics differ. Let’s expand our definitions by looking at the first major difference.

**File Composition**

File composition refers to the manner in which each graphic is created. The following two graphics are the same image (fig.1), but one is a vector image, and the other is a raster image.

A vector graphic is comprised of a series of mathematically defined objects. Fig.2, the vector image, is made up of 3 different "objects". Those objects (in this case an ellipse, a rectangle, and a polygon) each have their own different attributes such as colour (the ellipse is orange, the rectangle is blue, and the polygon is yellow). In each of the 3 objects, there is a separate mathematical formula which describes them.
Each object can be picked separately and moved around. Each object can also be placed at a different layer.

The raster based image (Fig. 3), on the other hand is much different. In order to show the composition of a raster graphic, the image has been enlarged. A raster graphic is made up of pixels. Pixels are individual picture elements that together form the raster based image. Each one of those little boxes (pixels) when put together, form the image.

When each object is drawn in a paint program, the objects are no longer separate entities but become one drawing. Each object can no longer be moved individually.

So how does this all fit together? Vector graphics are mathematically object defined, and raster graphics are composed of thousands of pixels. The following formula is an example of a vector graphic: \texttt{RECT 0, 0, 200,100, BLUE}. In a vector graphics environment this would display a blue rectangle. Because this object can be defined in this textual manner, very little file size is needed to create it. The vector graphics environment reads the mathematical formula and draws the rectangle on screen.

In order to create the same blue rectangle in terms of pixels (raster based image), you would need much more room to store it. The reason for this is that the rectangle would be comprised of hundreds of those little pixels. Each pixel requires its own space inside of the computer's memory. Pixels are not engineered via mathematics. They are there, physical entities each taking up the computer's resources.
Other Considerations

Colour Capability

Raster (Bitmap) – graphics, are composed of a matrix of pixels. For a monochrome image each pixel is either black or white, but for colour images each pixel can be any colour from a given range. The colour depth of the image depends on the amount of memory used to store each pixel. For example, in an image with an 8 bit colour depth each pixel can be one of 256 different colours (or shades of grey). The most common colour depths are, 4 bit=16 colours, 8 bit=256 colours, 16 bit=32,768 colours, 24 bit=16.7 million colours.

Colour look-up tables (CLUT) or palettes are often stored with bitmaps. These are an array of colours described as accurately as possible and referred to by specifying their position in the array (or map – bitmap). The example below (fig.5) shows a 256 colour look-up table where the colours are stored as 24 bit. This means that an image using this look-up table could consist of up to 256 colours chosen from 16.7 million colours. For example, where 43 is stored in the file, the colour red=181, green=113 and blue=86 is displayed.

Vector – All colour information is stored as a series of instructions, which can generate white on black, grey-scale, or full-colour (16.7 million) pictures.

fig.5
**Enlargement Capability**

Vector graphics are **resolution independent**. Raster graphics on the other hand, are **very dependant on resolution**.

A vector image can be resized freely without risking image degradation. The larger vector image in Fig.4 is a copy of the smaller version Fig.1. All of the lines of the larger vector image are crisp and smooth.

A raster image can't be resized freely without loss of image quality. In fig.5 the magnified area of the image, the lines are not smooth and crisp; pixelization has occurred. This is known as aliasing. A raster based image is resolution dependant. In other words it cannot be resized freely without risking image degradation.

**Printing Quality**

**Raster** (Bitmap) – The print quality is high provided that the image is made up of a large number of pixels (resolution) appropriate for the output device (printer). The image size is not increased.

**Vector** – The print quality is always high. The image always prints at the highest resolution of the output device.

When should these types be used?

**Vector graphics** are used for:

- Poster art and other high-contrast graphics
- Architectural plans, product designs, or other precise drawings
- Business graphics, charts, and "info-graphics"
- Traditional logos and text effects that require crisp, ultra-smooth edges
- Brochures, flyers, and other documents that mingle artwork, logos, and standard size text
- Flash based graphics aimed and Internet delivery
- Web based graphics that require certain effects (i.e. text on a path)
Raster graphics are used for:

- Scanned photos, including photographic collages, and embellishments that originate from scans
- Realistic artwork that relies on naturalistic highlights, midranges, and shadows
- Logos and other display type that feature soft edges, reflections or shadows
- Special effects that require the use of filters and colour enhancements that you can't achieve in a drawing program
- All other web graphics excluding Flash delivery & those graphics that have a specific effect (i.e. text on a path)

Software programs are required to create computer graphics (both vector and raster). The software market is full of graphics programs that let you create computer imagery. There are two basic types of programs:

- **Draw programs** - create vector based imagery (e.g. Macromedia Freehand, Corel Draw and drawing tools in MS Word, MS Publisher, PowerPoint)

- **Paint programs** - create raster (Bitmap) based imagery (e.g. Paintshop Pro, MS Paint, Adobe Photoshop)

The following table displays the different graphic files that you may encounter. Note that a few graphic files are made up of a combination of bitmapped and vector images.

<table>
<thead>
<tr>
<th>Format</th>
<th>Type</th>
<th>Ext.</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Bitmaps</td>
<td>bitmap</td>
<td>BMP</td>
<td>Best suited for white on black, 16-colour, and 256 colour images.</td>
</tr>
<tr>
<td>PC Paintbrush</td>
<td>bitmap</td>
<td>PCX</td>
<td>Best suited for white on black, 16-colour, and 256 colour images.</td>
</tr>
<tr>
<td>Tagged Image File Format 5.0</td>
<td>bitmap</td>
<td>TIF</td>
<td>TIFF format compression options are ideal for high-resolution images.</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
<td>vector</td>
<td>CGM</td>
<td>Most clip art in MS Clip Gallery are in this format.</td>
</tr>
<tr>
<td>Windows Metafile</td>
<td>vector</td>
<td>WMF</td>
<td>Can include bitmapped data as well, but rarely does.</td>
</tr>
<tr>
<td>Graphics Interchange Format</td>
<td>bitmap</td>
<td>GIF</td>
<td>Best suited for white on black, 16 colour, and 256 colour images. A popular graphics file format for the Internet.</td>
</tr>
<tr>
<td>Joint Photographic Experts Group</td>
<td>bitmap</td>
<td>JPG</td>
<td>The highly compressed JPEG format is ideal for high-resolution images. A popular graphics format for the Internet.</td>
</tr>
<tr>
<td>Encapsulated PostScript</td>
<td>bitmap</td>
<td>EPS</td>
<td>Can contain bitmapped and/or vector data.</td>
</tr>
</tbody>
</table>

Software programs are required to create computer graphics (both vector and raster). The software market is full of graphics programs that let you create computer imagery. There are two basic types of programs:

- **Draw programs** - create vector based imagery (e.g. Macromedia Freehand, Corel Draw and drawing tools in MS Word, MS Publisher, PowerPoint)

- **Paint programs** - create raster (Bitmap) based imagery (e.g. Paintshop Pro, MS Paint, Adobe Photoshop)

The following table displays the different graphic files that you may encounter. Note that a few graphic files are made up of a combination of bitmapped and vector images.

<table>
<thead>
<tr>
<th>Format</th>
<th>Type</th>
<th>Ext.</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Bitmaps</td>
<td>bitmap</td>
<td>BMP</td>
<td>Best suited for white on black, 16-colour, and 256 colour images.</td>
</tr>
<tr>
<td>PC Paintbrush</td>
<td>bitmap</td>
<td>PCX</td>
<td>Best suited for white on black, 16-colour, and 256 colour images.</td>
</tr>
<tr>
<td>Tagged Image File Format 5.0</td>
<td>bitmap</td>
<td>TIF</td>
<td>TIFF format compression options are ideal for high-resolution images.</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
<td>vector</td>
<td>CGM</td>
<td>Most clip art in MS Clip Gallery are in this format.</td>
</tr>
<tr>
<td>Windows Metafile</td>
<td>vector</td>
<td>WMF</td>
<td>Can include bitmapped data as well, but rarely does.</td>
</tr>
<tr>
<td>Graphics Interchange Format</td>
<td>bitmap</td>
<td>GIF</td>
<td>Best suited for white on black, 16 colour, and 256 colour images. A popular graphics file format for the Internet.</td>
</tr>
<tr>
<td>Joint Photographic Experts Group</td>
<td>bitmap</td>
<td>JPG</td>
<td>The highly compressed JPEG format is ideal for high-resolution images. A popular graphics format for the Internet.</td>
</tr>
<tr>
<td>Encapsulated PostScript</td>
<td>bitmap</td>
<td>EPS</td>
<td>Can contain bitmapped and/or vector data.</td>
</tr>
</tbody>
</table>
Clip Art

Clip art consists of ready-made pictures that you can include in your DTP/word-processed documents and presentations. These become extremely useful for users with limited drawing skills. Clip art can save you a lot of time when preparing your publications.

MS Clip Gallery

As indicated earlier on, there are several clip art libraries available for your use. Microsoft Office has a library of clip arts - the clip gallery - that you can use in your publications. The clip gallery contains both bitmap and vector images. More information and instructions about inserting clip art from the MS Clip gallery are available in the ‘Basic Computer Proficiency’ course pack available from the Teachers’ Resource Centre, Faculty of Education – University of Malta.

You can also use the clip arts available on CDs that you may purchase from any stationary shop. Some of these CDs contain many categories of graphics each of which contain hundreds of clip arts.

The Web

Several clip art libraries are also available on Internet. Some of these contain clip arts and images that you can download for free to your computer.

http://www.microsoft.com/clipgallerylive
http://www.clipartconnection.com
http://www.arttoday.com

These libraries have a search facility that can help you locate the clip art or image needed. Some of these libraries have links to other clip art libraries on the Web.

Scanning Images

The Scanner

As indicated earlier on, the scanner can also be used to acquire printed images to be included in your publication. The scanner is a device that uses technology similar to a photocopying machine to take an image from a printed page and convert it into a form the computer can manipulate. What follows is a basic introduction to get you started with scanning.

The flatbed scanner has a glass plate under a lid and a moving light that scans under it. This hardware device allows you to scan photos, paper documents, books, magazines, large maps and 3-dimensional objects (those that don’t have a lot of
depth e.g. coins). The scanner converts the printed images to digital images that can be stored in disks.

A standard software, referred to as TWAIN (Technology Without An Interesting Name), is used to operate the scanner. The TWAIN driver is the software provided by the scanner manufacturer to operate the scanner. TWAIN enables most programs - Word, PowerPoint, Publisher, Photo Editor, Imaging - to start and control the scanning operation. This means that you can use different programs but you need to use the TWAIN driver that comes along with your scanner.

Different scanner brands use different names for their TWAIN software. The scanner available at the Computing Services Centre, University of Malta, uses TWAIN software called HP ScanJet software.

**Scan for the Capability of Output Device**

Choose the scan resolution based strictly on the needs of the output device that will process that image. That output device is normally a printer for handouts and charts or a monitor for presentations and Web pages.

Video monitors and printers work very differently from each other, and all of the rules are different for images intended for these two devices. The following table details the significance of these differences.

<table>
<thead>
<tr>
<th>Properties of Printed Images</th>
<th>Properties of Video Screen Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image size is measured in inches</td>
<td>Image size is measured in pixels</td>
</tr>
<tr>
<td>Image size does NOT vary with scanned resolution</td>
<td>Image size varies with scanned resolution</td>
</tr>
<tr>
<td>Image size is modified on paper by scaling</td>
<td>Image size is modified on screen by resampling</td>
</tr>
<tr>
<td>Image pixels are spaced on paper using specified scaled resolution</td>
<td>Image pixels are located at each screen pixel location, one for one</td>
</tr>
<tr>
<td>Several printer ink dots are used to represent colour of one image pixel</td>
<td>One screen pixel location contains one image pixel, and can be of any RGB value</td>
</tr>
</tbody>
</table>

Digital images are built of pixels, which are sampled numeric RGB (Red Green Blue) colour data values.

The scanner creates pixels by sampling the original photograph at say 100 dpi to create that number of samples or pixels per inch. The size (in inches) of the
original photograph is as important to image size as is the resolution in dpi. A 6 inch (15 cms) photograph scanned at 100 dpi will produce \((6\times100) = 600\) pixels across that dimension of the image. Or, a 1 inch section of photograph scanned at 600 dpi will also create an image with a dimension of \((1\times600) = 600\) pixels.

![Original image to be scanned at 600 dpi (dots per inch)](image1)

**Fig. 8** The 1" scan at 600 dpi (Dots per inch) printed on A4 paper.
Size = 1" (2.5 cm)

![The scan at 600 dpi fills 600 pixels on screen.](image2)

**Fig. 9** The scan at 600 dpi fills 600 pixels on screen.
Different Concepts of the Word ‘Resolution’ in Images:

- **While scanning** - when creating the image, resolution determines the spacing of the pixel samples taken from the original master copy. If we scan a width of 1 inches at 600 dpi, we create an output image width of 600 pixels. This is basically all resolution does, and then the output device takes over.

- **While on screen** - Scanned resolution no longer has any meaning other than size. The image width of 600 pixels will occupy 600 pixel positions on the screen, which might be 640 or 800 pixels wide itself (figure 9).

- **While printing** - Resolution is just a remembered number from the original scan, and now it is used to determine the printed spacing of the pixels on the paper. 600 pixels at 600 dpi will print as a 1 inch width, same as the size of the scanned original.

So, how much resolution for printing? That's dependent on the capabilities of the output device. You always scan for the output device. You should not swamp the printer with a huge image, causing a flood of excessive pixels for which it has no use.

Beginners tend to opt for the highest resolution possible during scanning. However, they will soon realise that high resolution full-colour scans will produce digital images that take up a lot of memory. The following table displays the memory sizes of a 6×4 inch image scanned at different resolutions:

<table>
<thead>
<tr>
<th>Scan Resolution</th>
<th>Memory size in kilobytes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Black &amp; White</td>
</tr>
<tr>
<td>75 dpi</td>
<td>16.9kb</td>
</tr>
<tr>
<td>150 dpi</td>
<td>67.5kb</td>
</tr>
<tr>
<td>300 dpi</td>
<td>270kb</td>
</tr>
<tr>
<td>600 dpi</td>
<td>1,080kb or 1.08Mb</td>
</tr>
</tbody>
</table>

When creating an image with a scanner, you will want to produce the smallest possible file size without degrading image quality. To accomplish this, you should scan a picture with the colours and resolution appropriate to the output device (printer or monitor). For example, you should not create a full-colour scanned image if you will be printing to a black and white printer. There are no hard and fast rules concerning scanning parameters. The following table lists the most efficient resolutions for standard output devices:
### Colour Printers

Colour printers must print several of the printer's dots for each image. Inkjets have only 3 or 4 colours of ink, a few have 6 colours, and this is all they can print. They CANNOT print any one of 16 million colours on any one dot. So to represent each image pixel in various colours, shades, and intensities, the image is dithered, meaning the printer uses a pattern of several of its dots to simulate the colour of each pixel in the image.

It is clear that we don't get anywhere near 600 or 720 dpi of "image" resolution from our printers in colour mode. This requirement for multiple printer dots for one image pixel greatly reduces the printer's real image resolution capability to a fraction of the printer's advertised dpi.

Printer specifications are real and accurate and meaningful, but are not to be confused with image resolution. Printer ink dots and image pixels are simply very different things, and one colour image pixel requires many printer ink dots. This is why we need a 600 or 720 dpi printer to print an image at 150 or 200 dpi.

### First steps

Before you create a scanned image, you must establish a link between Publisher and the scanner.

1. Click the Insert menu.
2. Highlight Picture.
3. Highlight from Scanner or Camera.
4. Click Select device. The Select Source dialog box is displayed.
5. Choose the device (either the scanner or digital camera) that you wish to use.
6. Click OK button.
The above should start the TWAIN software which is specific to the type of scanner you have. The HP ScanJet software will be used to show the scanning operation.

1. Place the printed document under the lid of the scanner.
2. In the HP Precision Scan Pro window, click the Scan menu.
3. Click the Preview command. This option will produce a quick and low-resolution scan of the printed document on the scanner glass bed.

The appropriate controls have to be set before performing the final scan of your printed document. These controls include setting the scan mode (colour, black & white or line-art), the resolution of the scan, the area of the document to scan the correct tonal quality and colour balance of the scan etc.

**Type of Scan**

You can scan an image using different modes:

- **Colour** – This scan mode produces images that can have up to 16.7 million colours. This mode is appropriate for scanning full-colour pictures.

- **Grey Scale** – This scan mode produces images with 256 shades of grey - similar to black and white photos. This mode is appropriate for scanning photos, pencil drawings etc.

- **Line Art** – This scan mode produces images with two colours - either white or black. There is no grey. This mode produces images with a lot of contrast and therefore is a very poor choice for photo scanning. Line art mode is ideal for scanning pages of printed text which will not be edited.

**Acquiring the Scan**

Further to the control settings explained in the previous sections you need to select the area to be scanned. This is usually done by creating a frame over the appropriate area in the preview image. The mouse is used to create the frame. To acquire the scan:

1. In HP PrecisionScan Pro Window, click the Scan menu.
2. Click Save As… The Save As dialog box will be displayed.
3. Select the location (disk/folder) where the image file will be saved.
4. Type a name for the scanned image in the File name: field.
5. Select an appropriate file format for your image (refer to the next section).
6. Click Save button.

The scanner will perform the final scan of the selected area of the image. The time taken to perform the scan depends on the scan mode and the quality of the scanner. The image will be transferred to the program (PhotoEditor, Word, PowerPoint, Publisher) used.
Graphic File Types

By now you have learnt that there are different graphic file types and that some high resolution scans may take up a lot of memory. A common question is the following: What file format should be used to reduce the size of the scanned image without compromising the image quality?

The three most common graphic file formats are: TIF, JPG and GIF.

Tag Image File Format (.TIF files)

TIF is one of the best possible file formats for the master copies of scanned images i.e. those that you will use and edit in the future. TIFF is the most widely supported format across different operating systems (PC, Macintosh, OS, Unix).

TIFF writes a large file, and it uses lossless compression, meaning that you can always read back in what you wrote out, without data corruption. If you might ever be modifying and writing the file a second time, then use a non-lossy format like TIFF. TIF files are large, huge even, but it's the price we pay.

JPEG - Joint Photographic Experts Group (.JPG files, pronounced Jay Peg)

This is the best format for scanned photographs used on web sites because the file is small, often compressed to only 1/10 or 1/20 size. However, this fantastic compression efficiency comes with a price. JPG uses a lossy compression, that is, some quality is lost when the file is written (saved), and it cannot be recovered. Even worse, a little more quality is lost every time the JPG file is compressed and saved again.

So therefore, because of quality problems, JPG is NOT suitable for storing a master copy of your data.

A JPG file can be read and viewed indefinitely without affecting the data, like on a web page say, but every time the file is saved, the JPG compression causes additional image quality to be lost.

When you write a JPG file, your FILE - SAVE AS dialog box has an Option Button. Under that Option button is an option for file compression or quality. The Quality or Compression numbers are relative and have no absolute meaning, and will vary in effect from one program to another. Using JPG Quality higher than about 90% is unnecessary, because 100% is just a number in this case, and it does NOT mean NO compression. JPG will always compress, and 90% is not much different than 100%.
Good JPG compression values for routine use are 75-80% Quality, or 20-25% Compression. Too little Quality or too much Compression will affect image quality visibly. You will see artifacts (fig.10) where the edges are blurred and contain some false colour, and the smooth background colours become "blocky", with similar colours merged into 8x8 blocks of the same one colour. Harmed most are sharp contrasting edges, like text letters, graphic art, etc. But for normal photographs, images of "objects found in nature" as they say, as opposed to graphic line art, then JPG files with 75% quality or 25% compression are normally very acceptable, and the small file size is very desirable.

**GIF - Graphic Interchange Format. (.GIF files. pronounced Jiff)**

This is an older format developed by CompuServe. GIF is limited to 256 colours. It is the conversion to 256 colours that cause the colour losses, and the file format itself is lossless. You can read and write GIF files multiple times without additional losses. So GIF uses lossless compression, like TIF. In other words, an image which has, say 200 colours, will not suffer any colour loss when saved as a GIF.

GIF is the smallest file for 16 or 256 colour data like graphic art or screen captures or 2 colour Line art, and is the format of choice for that kind of graphic images. Simple images like a company logo should be reduced to 16 colours if possible and saved as a GIF for the smallest size. Some image programs will convert to any number of colours, and a complex logo might look bad at 16 colours, but look very good at say 43 colours. The fewer colours, the smaller the GIF file.

GIF files are best suited for simple graphics, like logos, containing solid areas in few colours. GIF also optionally offers transparent backgrounds. When you select GIF format, your FILE - SAVE AS dialog box has an Option Button. Under that Option button is an option for transparency, to specify which one GIF palette index is to be transparent.

As indicated earlier on there are other graphic file formats which you can use:
Windows Bitmap (BMP) & Windows Paintbrush (PCX)

These formats are used for bitmap graphics on the Windows platform only. BMP and PCX files use a lossless compression and therefore generate large image sizes.

Encapsulated PostScript (EPS)

This format can be used on all platforms. EPS files can be graphics or images of whole pages that include text, font, graphic and page layout information.

Manipulating Images

Whether you use commercial clip art, create an original drawing, or scan personal photographs, you might want to use Publisher’s picture editing tools to resize, crop or otherwise modify pictures.

Scaling an Image

The scale picture command allows you to change the size of a picture:

1. Select the frame containing the image to resize.
2. Click the Format menu. The Scale Picture dialog box appears.
3. Type equal percentage values in the Scale height: and Scale width: fields to maintain the aspect ratio (original proportions) of the image.
4. Click OK button.

Note that:

Bitmap images should be used at their original size. Scaling a bitmap image will seriously degrade its quality. Bitmap images can be resized in a dedicated image editing program.

If you distort an image and then want to return it to its original size, tick the Original Size check box in the Scale Picture dialog box. Publisher returns the height and width to 100 per cent.
Featuring a Section of an Image

You can hide portions of an image by using the Crop Picture tool. Think of the picture frame as a window. Using the Crop Picture tool is like pulling the window shade up or down. Cropping is not the same as resizing, which enlarges or shrinks the entire image.

1. Select the frame which contains the image to crop.
2. Click the Crop Picture button.
3. Position the pointer over any sizing handle. The pointer changes into the Crop pointer.
4. Drag the sizing handle inward until the portion of the picture that you want to be visible will be displayed. Repeat this step with any of the other sizing handles to achieve the effect you want.
5. Click the Crop Picture button when finished.

![Crop Image](image)

Restoring the Cropped Portions of your Image

1. Repeat steps 1-3 as for above.
2. Drag the appropriate sizing handles outwards.
3. Click the Crop Picture button when finished.

Colour Options for Imported Images

Publisher allows you to change all colours in an imported picture. You might want to change a colour scheme for artistic reasons or for technical reasons regarding the capability of your printer. For example, you would recolour a multicoloured picture to shades of grey if you have a black-and-white printer.

1. Select the frame which contains the image to recolor.
2. Click the Format menu.
3. Click Recolor Picture… The Recolor Picture dialog box.
4. Click the arrow next to Color: and select the colour you want e.g. grey. To view more colours, click the More Colors button.
5. Select the radio button: Recolor whole picture to colour of the entire object to the colour you have selected. OR
1. Leave black parts black if you want to leave black parts of your object black while changing the colour of the rest of your object to the colour you have selected.
2. Click Apply button to preview the recoloured picture in the actual document.
3. Click OK button to accept the settings.

**Restoring the Colours of the Image to the Original Settings**

1. Repeat steps 1-3 as for above.
2. Click Restore Original Colors button.
3. Repeat steps 6-7 as for above.

**Text Wrapping**

The strength of a DTP program is its ease of laying text and graphics on a page. You can wrap text around any frame including picture frames. To wrap text around a frame:

1. Click the frame that you want to flow text around.
2. Click the Arrange menu.
3. Click Bring to Front. The text wraps around the frame.

This creates a rectangle of blank space around the picture.
You can also wrap text around the outline of the image itself rather than around the rectangular frame.

1. Repeat steps 1-2 as for above.
2. Click the Format menu.
3. Click the Picture Frame Properties. The Picture Frame Properties will be displayed.
4. Tick the Picture only radio button.
5. Click OK button.

You can also click the Wrap Text to Picture button to wrap text around the outline of the image.

**Fine-tuning the Text Wrap**

When you wrap text around a picture, Publisher maintains a nonprinting boundary between the image and text. This boundary can be adjusted as follows:

1. Select the image to adjust its wrapping.
2. Click the Wrap Text to Picture button.
3. Click the Format menu.
4. Click Edit Irregular Wrap… Adjust handles appear along the dotted boundary line.
5. Position the pointer over one of the Adjust handles. The Pointer changes to the Adjust border.
6. Drag the Adjust handle to change the shape of the boundary around the image.
7. Release the mouse button.

The text rewraps around the newly formed boundary.
Adding/Deleting Adjust Handles

You can also add or delete handles in an irregular text wrapping boundary:

1. Repeat steps 1-4 as for above.

2. a. To add an Adjust handle: position the pointer along the text wrapping boundary where you want the new handle to appear. Press and hold down the Ctrl key – to turn the pointer into the Add pointer. Click the left mouse button.

b. To delete an Adjust handle: position the pointer over a handle you don’t need. Press and hold down the Delete key – to turn the pointer into the Delete pointer. Click the left mouse button.
Educational Resources

ACTIVITY 5

During this activity you will create part of a school newsletter. The text for this worksheet has been word-processed using MS Word. You will transfer this text to MS Publisher and work on its layout. You will also use clip art available from the MS Clip Art Gallery and clip art available on the Web. By the end of this session the newsletter should look like the one at the end of this documentation. The emphasis of this activity should be on the skills used to create the newsletter rather than on the content.

Beginning the Newsletter
1. Start the program MS Publisher.
2. Open a blank full page publication. The size of the page should be A4.
3. Set the orientation of your publication to portrait.
4. Set the layout guides as indicated below:
   - Left 1.5cm
   - Top 1.5cm
   - Right 1.5cm
   - Bottom 1.5cm
5. Save this publication as Part Newsletter.pub.
6. Save your work.

Text Frame 1
1. Create a text frame at the top of the page.
2. Type School LINK…
3. Apply the font Berlin Sans FB Demi point size 24 to this text. Set the size of the text frame accordingly. Apply shadow to the word School. Apply outline and shadow format to the word LINK…
4. Draw 2 straight lines (2 point) below the frame as shown.
5. Save your work.

Text Frame 2
1. Create a text frame below the first frame.
2. Switch to MS Word and open the file newsletter articles. Highlight the That’s Entertainment up to Meli – 4 Green. Click on the Copy button.
3. Switch to MS Publisher and paste this text in the text frame.
4. Apply the font Franklin Gothic Demi point size 31 to the title That’s Entertainment. Apply the font Tahoma point size 11 to the rest of the text. Set the size of the text frame accordingly.
5. Insert three clip arts from the clip art gallery and the web. Resize and position the three clip arts in the frame as shown. Recolor the three clip arts to grey scale. The third clip art should have text closely wrapped around its contours.
6. Apply a 2 pt straight line border to the frame.

Text Frame 3
1. Create a text frame below the second frame.
2. Type the text Żomm l-Indafa Kullimkien!
3. Apply the font Arial Black point size 20 to this text. Set the size of the text frame accordingly.
4. Apply the border shown. This border can be applied through the border-art feature. Use Publisher’s on line help to apply this border.
5. Save your work.

Text Frame 4
1. Create a text frame below the first frame.
2. Type the text Ghandek xi problema? Ċempel il-Helpline.
3. Apply the font Arial Black point size 18 to this text. Set the size of the text frame accordingly.
4. Create another text frame below this frame.
5. Insert the telephone symbol and 179.
6. Apply the font Arial Black point size 28 to this text. Set the size of the text frame accordingly.
7. Apply white colour to the symbol and number. Apply a black fill colour to the frame.
8. Apply a 2 point straight border to both frames.
9. Save your work.

Text Frame 5
1. Create a text frame below the fourth frame.
2. Switch to MS Word and open the file newsletter articles. Highlight the Mediterraneo up to Tanti – 5A. Click on the Copy button.
3. Switch to MS Publisher and paste this text in the text frame.
4. Apply the font Tahoma point size 14 to the title Mediterraneo. Apply the font Tahoma point size 11 to the rest of the text. Set the size of the text frame accordingly.
5. Apply a 2 pt straight line border to the frame.
6. Save your work.
Educational Resources

ACTIVITY 6

During this activity you will create the first page of a handout. For this exercise you may scan your own photographs and insert the appropriate content of your own choice. You will scan three photographs to the specified size so that minimal resizing is required and the best file size is acquired. By the end of this session the page should look like the one at the end of this documentation.

Beginning the Handout
1. Start the program MS Publisher.
2. Open a blank full page publication. The size of the page should be A4.
3. Set the orientation of your publication to landscape.
4. Set the layout guides as indicated below(Arrange > Layout Guides):
5. Margin guides: Left 1.5cm Top 2.5cm
   Right 1.5cm Bottom 2.5cm
6. Grid guides: Columns 2 Rows 1
7. Set up other horizontal and vertical guide lines at the distances shown on the finished example. You may want to zoom control to 400% for greater control.
8. Save this publication as SummerHandout.pub.

Text Frame 1 (main title)
1. Create a text frame at the top of the page.
2. Type SUMMER (or the title of your choice).
3. Apply a suitable font, point size 48 to this text. Set the size of the text frame accordingly.
4. Save your work.

Text Frame 2 (sub title)
1. Create a text frame to accommodate The Sandcastle text. (ref. to the finished example)
2. Click on Insert on the menu bar and choose Text File... Open the document Summer.
3. Apply the font Verdana, bold, point size 24 to the sub title The Sandcastle. Apply the font Verdana point size 11 to the rest of the text. Apply Bold to the author’s name. Set the size of the text frame accordingly.
4. Save your work.
First Scan
1. Create a picture frame below the main title. Use the guides to create an approximate square frame for the largest photograph.
2. While the frame is still selected, right mouse click inside it.
3. Select Change Picture > Picture > From Scanner or Camera > Acquire Image.
4. Scan the first photograph (your own or the boy playing with the sand).
5. Save your work.

Second Scan
1. Create a picture frame to the left of the sub title. Use the guides to create a frame for the smallest photograph.
2. While the frame is still selected, choose Insert from the menu bar.
3. Select Picture and continue to acquire the image using Publisher as the TWAIN driver.
4. Alternatively, you can get the photograph From File… if the image was saved prior to this exercise, using a paint program such as Paint Shop Pro.
5. Scan the second photograph (your own or the boy with the straw).
6. Save your work.

Third Scan
1. Create the last picture frame by starting from inside the text frame on the right. Use the guides to create a frame for the last photograph. The text should automatically wrap around the picture frame.
2. While the frame is still selected, choose Insert from the menu bar.
3. Select Picture and continue to acquire the image using Publisher as the TWAIN driver or from file if the image was created earlier.
4. Scan and save.

Final Touches
1. Create a text frame for the footer. Insert your own text.
2. Draw the lines running from the title down to the lower right hand corner.
3. Use the Line Tool to draw the lines and More styles from the Line/Border Style button to format the line.
4. You may use a 4 point for the line thickness.
5. Publisher helps you select the colour for the line by providing a colour scheme.
6. Save your work.
That's Entertainment

The month of December always brings a circus to Malta. This year the Maltese people were invited to watch an Italian circus called Citta' di Roma perform. During the show the audience saw llamas, water buffaloes, elephants, majestic Siberian tigers, horses, ponies and camels. These were also performances by jugglers, acrobats and clowns.

The ringmaster opened the show by introducing the tigers. Iron bars were erected in the ring to protect the audience. Only their trainer was allowed in the ring with them. Only his skill protected. The tigers jumped from one platform to another and also through rings of fire.

Then came the camels. A man balanced on the back of one of the camels. He made them run round the ring in time to the music. After came the llamas and they joined the camels round the ring. The horses and the three little ponies were truly magnificent. On their way out of the ring they all stopped and nodded to the audience.

I think the children looked forward to the elephants' performance most. At one point, a pretty young woman, who was riding on one of the elephants, got off and lay on the ground; an elephant knelt over her. One use move and the elephant would have squashed her! It is amazing how many learn through the hard work of their trainers. Wouldn't we all like to fly? Through the air like trapeze performers juggle balls and plates as if it was the easiest thing in the world! Wouldn't it be wonderful to make people laugh like the clown who also asked people from the audience to join in his act?

All I can say is that everyone leaves the Big Top with a beaming smile on his or her faces. So the circus is not something to miss. Who knows, maybe you will find circus life to your liking and you too will join the world’s greatest show.

Mary Meli - 4 Green

Ghandek xi problema?
Cempel il-Helpline

Mediterraneo...

At about 10:30 we went to the aquariums. There were splendid fish. One fish that impressed me most was the scorpion fish. This fish is poisonous. There were also starfish and anemones in the aquariums! After we had our lunch break, we started the worksheet activity. We went to the souvenir shop and bought something to remind us of the Mediterraneo Marine Park.

At about 11:30 there was the dolphin show. It was very exciting and beautiful. During this show a man played with the dolphins. A girl was chosen for a ride on the dolphins. Nearly everybody was taking photos because this was incredible for us.

At the end it was sad to leave but we had to return to school to be on time for the 12 o’clock break. During break everybody was talking about this visit.

Luke Tanti - 5A
The Sandcastle
by MALCOLM LEIGH

"If your rotton must does that again," yelled Philip. "I bury it!"

"Don't shout, darling," sighed Philip's mother, barely lifting her head from her book. She was stretched elegantly on a sun-bond. It was, she said, "too much of a task," even if the children did promise to look after it themselves.

"It's not a must anyway," she said. "It's lovely. I wish it were mine." Actually, Philip thought so, too. He'd have loved a dog, but his mother said it would be "too much of a task," even if the children did promise to look after it themselves.